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Einflhrung 5
Giris

Belirli bir alana odaklanan literattr incelemesi, bircok bilimsel alanin temel unsurunu olusturmaktadir. ilgili
alanyazinin sistematik bir sekilde analiz edilip sunulmadigi bir projeye ya da teze denk gelme ihtimalimiz ol-
dukca dUstktar (Creswell, 2016, pp. 58-66). Her gecen glin artan sayida yayinevinin, dergileri ve makaleleri
cevrimici erisilebilir hale getirmesiyle, literatlr taramalarinin olusturulmasi daha kolay ve etkin bir hal almstir.
MAXQDA, literattr taramalarinin olusturulmasi (6rnegin, teori bélimlerinin ve arastirma raporlarinin hazirlan-
masi) ve sistematik incelemeler ile meta-analiz ¢alismalarinda arastirma sonugclarinin hazirlanmasi gibi literatGr
ile ilgili gundelik isler icin oldukca uygundur. MAXQDA, ¢zellikle notlarin organize edilmesi ve yonetilmesi ile
arastirma surecini desteklemek icin 6zetlerin olusturulmasi amaciyla kullanilabilir. Literattr Gzerine calisirken,
bibliyografik bilgiler (yazar, yayin yili gibi) literatr iceriginden ayri degerlendirilmelidir. MAXQDA genellikle
icerige odaklanir ve referans yonetim programlarinin sagladigi 6zellikleri sunmaz. Ancak, referans yénetim
programlarindaki veriler MAXQDA programina aktarilarak Uzerinde cesitli islemlerin yapiimasi mimkundur.

Bu kilavuzda:

e Bibliyografik veriler ve tam metinler ile calisma

e Referans yonetim programlarindan ve (cevrimici) veritabanlarindan veriyi iceri aktarma

e Literatlr ve Ozetler ile ilgili glnluk isleri yerine getirme

e LiteratUr taramasi yapma ve

e Sistematik incelemeleri gerceklestirmek icin mimkUn olan secenekler Gzerinde durulmaktadir.



6 MAXQDA ile Literattr Taramasi

Referans yonetim programlarindan bibliyografik veriler ve tam
metinler ile calisma

MAXQDA, kullanicilara Mendeley, EndNote, Citavi ve Zotero gibi referans ydnetim programlarindan bibliyog-
rafik verilerin iceri aktarilmasi firsatini sunmaktadir. MAXQDA programinda oldugu gibi bu referans yonetim
programlari toplanmis olan tim bibliyografik verileri iceren proje dosyalarini, yani veri tabanlarini, kullanir.
Boylesi bir projede en kictk birim bibliyografik ktnyedir (6r., yazar, baslk vb.). Bu kiinye internet sitelerine,
anahtar kelimelere, 6zetlere, tam metinlere ve diger bilgilere erisim baglantisi icerir.

MAXQDA, ilgili literatlr veri tabanlarindan RIS formatinda disariya veri cikartabilen tim referans yonetim
programlari ile uyumludur. RIS bibliyografik veri icin standart bir format olmakla birlikte Citavi, DocEar, End-
note, JabRef, Mendeley ve Zotero gibi siklikla kullanilan literattr yénetim programlarinda kullanilmaktadir.
Boylece, bu programlardan secilen literatlrt veya ilgili literattrin tamamini iceren girdileri MAXQDA progra-
mina aktarabilirsiniz. LiteratUr kiinyesinin yani sira ilgili referanslarin tam metinlerinin de MAXQDA progra-
mina aktariimasi su programlar ile mumkundur:

o (Citavi

e Endnote
e Mendeley
e /otero

MAXQDA programina aktarildiginda, her bir literattr kaydi bash basina bir metin belgesi halini almaktadir.
Eger tam metinler ice aktariimissa, MAXQDA otomatik olarak tam metin ile ilgili literattr kaydinin arasinda
bir baglanti kurar. Literatur kayitlarindaki bilgiler otomatik olarak sonraki adimlarda uygulanacak olan analiz-
ler icin kodlanir. Béylece tim basliklar veya 6zetler bir araya getirilebilir ve taranabilir. Eklentiler, iceri aktarma
sUrecinde otomatik olarak anahtar kelimeler kullanilarak kodlanabilir ve her bir literatlr kaydi icin notlar do-
kiman memosu olarak ilgili eklenti dosyasi ile birlikte kaydedilebilir. Metnin devaminda yer alan gérsel,
MAXQDA programinin referanslari "REFERENCES" (REFERANSLAR) ve ilgili tam metinleri "REFERENCES > AT-
TACHMENTS" (REFERANSLAR > EKLER) ice aktarirken belge gruplarini nasil olusturdugunu géstermektedir.
Gorselde sadece bir referans (Bryman 2007) ve ilgili tam metin ek olarak iceri aktariimis ve kaydedilmistir.
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3 Documents
v BIREFERENCES
[ Bryman, Alan - 2007
v B REFERENCES > ATTACHMENTS
Bryman (2007). Barriers to integrating quantitative and qualita

RIS verisi olarak iceri aktarilan referanslar ve ekler icin dosya organizasyon semasi

Bibliyografik veriler icin RIS dosya formati

RIS, “Arastirma Bilgi Sistemi” (Research Information System) formatinin kisaltiimis halidir. RIS dosyalari disa
aktarilan tUm literatdr kayitlarinin birbiri ardina listelendigi basit veri dosyalaridir. RIS dosyalari “etiket” olarak
adlandirilan ve iki harften olusan bilgileri icerir. Onemli etiketlere 6rnek olarak:

TY — Referans tipi (TYpe of reference), genellikle yeni bir kaydin baslangicini isaretler

ID — Her bir kayit icin 6zguin kayit numarasi (Unique IDentification number for each entry)
AU - Yazar (AUthor)

Tl — Baglik (Tltle)

PY — Yayin yili (Publication date/Year)

ER — Kaydi sonlandirma (Closes EntRy), her zaman kaydin sonunda yer alir

RIS formati etiketleri hakkinda daha detayli bilgi edinmek icin Wikipedia linki ziyaret edebilirsiniz:
https://en.wikipedia.org/wiki/RIS_(file_format). RIS kaynak veri 6rnegi asagida listelenmistir:

TY - KITAP

AU - McLuhan, Marshall (ilk yazar)

AU - Fiore, Quentin (ikinciyazar)

TI - The medium is the message: An inventory of effects (Bas/k)

PY - 1967 (1l

CY - New York, NY (Yayin yeri)

PB - Bantam Books (Yayinevi)

ER -
Not: italik ve parantez icinde sunulan bilgiler, cevirmen tarafindan okuyucuya kolaylik saglamak amaciyla ek-
lenmistir.
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Citavi, Endnote, Mendeley, veya Zotero programlarindan literatur verisini disa ak-

tarma

MAXQDA programina literatdr verisi aktarmadan énce, istenilen veriyi kullandiginiz literatdr ydnetim progra-
mindan RIS formatinda disar aktarmaniz gerekmektedir. Citavi, Endnote, Mendeley ve Zotero programlarinin

hepsi icin ilgili veriyi disari aktarmak benzer bir yolla gerceklestirilir.

Citavi'den Veriyi Disa Aktarma

1. Solda yer alan referans listesinden disa aktarilacak olan kayitlari seciniz. Eger tim referans kayitlarini disa

aktarmayu istiyorsaniz, secim yapmak gerekli degildir.

2. Disa aktarma islemini File > Export > Export> RIS... (Dosya > Disa aktar > Disa aktar > RIS...) ilk asamada
“RIS” filtresini + Add export filter (+ Disa aktarma filtresi ekle) adimi ile eklemek gerekli olabilir.

3. Sonraki asamada, Save to text file: (Dosyay: kaydet:) fonksiyonunu secerek Browse... (Ara...) fonksiyo-

nunu dosya adini ve kayit yerini belirlemek icin kullaniniz.

4. Eger ilerleyen asamalarda bu tip disa aktarma islemi gerceklestirmek istiyorsaniz, bu islemi “export temp-

late” ("taslagi disa aktar") secenegi ile son adim olarak kaydediniz.

Endnote’tan Veriyi Disa Aktarma
1. Disa aktarmak istediginiz literattr kayitlarini seciniz.

2. File > Export... (Dosya > Disa aktar...) adimlarini ana mentden
seciniz.

3. Bir dosya adi girerek hedef dizini seginiz.

4. Dokiman tipini “Text Only” olarak seciniz ve ¢ikti stilini “Ref-
Man (RIS) Export” olarak resimde gosterildigi gibi seciniz. Eger
bu cikti stili secenek olarak sunulmuyorsa, secim listesini acarak
en Ustte yer alan “Select Another Style...” kismindan ¢ikti sti-
lini-arayip ilgili secimi yapiniz.

5. Save (Kaydet) butonuna basarak islemi kaydediniz.

Save As:| My EndNote Library ‘

Tags:

Where: Literaturdaten B

<

Save file as type: = Text Only

Output Style: RefMan (RIS) Export

Export Selected References

Cancel
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Mendeley’'den Veriyi Disa Aktarma

1. Disa aktarmak istediginiz literattr kayitlarini seciniz.

2. Ana meniden File > Export... (Dosya > Disa aktar...) se¢imini yapiniz.

3. Dosyaya bir ad vererek kayit yerini seciniz.

4. Dosya tipini “RIS - Research Information Systems (*.ris)" olarak seciniz.
5

Save (Kaydet) butonuna basarak islemi kaydediniz.

Zotero'dan Veriyi Disa Aktarma

1. Disa aktarmak istediginiz dékdman grubunu secip sag tiklayarak Export Collection... (Disa aktar...) adi-
mini seciniz. Alternatif olarak, ana menuden File > Export Library... (Dosya > Kutlphaneyi Disa Aktar...)
secenegini kullanarak tim kdtdphaneyi disari aktarabilirsiniz.

2. Karsiniza ¢ikan diyalogda “RIS” formatini seciniz. Format: [ RIS

3. Eger notlar ve referansla ilgili dosyalari (6zellikle tam
metinleri) disar aktarmak isterseniz, Export Notes
(Notlan Disa Aktar) and Export Files (Dosyalan Disa
Aktar) ilgili kutucuklarini sectiginizden emin olunuz.

Translator Options

Export Notes
Export Files
Character Encoding:

4. OK (Tamam), tusuna bastiktan sonra bir dosya adi Unicode (UTF-8)

vererek hedef dizini seciniz.
5. Save (Kaydet) butonuna basarak islemi kaydediniz. Cancel | (TSN
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MAXQDA programinda ice aktarma ve otomatik 6n-kodlama

RIS dosyalari “Import > Reference Manager Data” (ice aktar> Referans Yonetici Verisi) adimlan takip edilerek
MAXQDA programina aktarilabilir. ilgili adimlar takip edildiginde RIS veya TXT uzantisi ile secilecek ilgili dos-
yanin icinde yer aldigi bir secim kutusu ortaya ¢ikar. iceri aktarma strecinde, su islemler gerceklesir:

e “Document System” (“Belge Sistemi”) icinde “REFERENCES"” (“REFERANSLAR") adi verilen bir belge

grubu olusturulur.

e TUm literatdr kayitlar, yeni olusturulan belge gruplarina bagimsiz veri belgeleri olarak eklenir. Kayitlar
alfabetik olarak siralanir ve kendi sembolleri ile isaretlenir.

e Belge adi, yazarlarin isim ve soyisimlerinin yani sira yayin yili bilgilerini icermektedir. iki yazarl yayinlarda
yazarlar ve isareti (“&") ile iliskilendirilir. U¢ veya daha fazla yazar olmasi durumunda ise sadece ilk yaza-
rin bilgileri verilir ve diger yazarlar icin “ve digerleri” anlamina gelen (“et al.”) ifadesi eklenir.

IR Document System |5 [ ANk P #H ©=x X

v  PuDocuments 239
v  PUREFERENCES 217
[ Abe, Ryosuke - 2019 20
Baumann, Martina F. et al. - 2019 23
Blyth, Pascale-L. - 2019 19
Botello, Bryan et al. - 2019 22
Elgharbawy, M. et al. - 2019 24
Janssen, Christian P. et al. - 2019 20
Javanmardi, Ehsan et al. - 2019 24
Kim, Chansung et al. - 2019 22
Rahman, Md Mahmudur et al. - 2019 21
Sheehan, Barry et al. - 2019 22
v MU REFERENCES > ATTACHMENTS 22
Abe - 2019 - Introducing autonomous buses ... 2
[ Baumann et al. - 2019 - Taking responsibility... 3

@ Code System g P f# @I X
v  ‘@Code System 239
v @¢REFERENCES 0
@qRIS 195
v  EgKEYWORDS 0
@4 Autonomous driving 20
AR iar intaraatian 2
Keywords as Codes 2
©g'Old people 2
@g'Responsibility 2
@ Risk classification 2
(@' Self-localization 2
(g Transportation system 4
@©g Trucks 2
©aUrban area 2

MAXQDA programina aktarilmis olan literattr

[4 Document Browser: Abe, Ryosuke - 2019

.TY_Type of referen$

..TI_Book title {

..AU_Author ¢

..PY_Publication yez §

..DA Date §

..J2_Periodical nam §
.VL_Volume numbe §
..SP_Start page nun §

..EP_Ending page nt§

..L1_Link to PDF ¢

LSOm0 ®E L % ©3x X
oY e 3 @

JOUR

Introducing autonomous buses and taxis: Quantifying the potential benefits in Japanese
transportation systems

Abe, Ryosuke Bibliographic information

2018 imported as a text document

2019/08//

Transportation Research Part A: Policy and Practice

126

94

113

Abe - 2019 - Introducing autonomous buses and taxis Quantifyin.pdf

The introc Link to PDF and taxis is expected to generate such benefits as cost
reductions ... __.L_o.C.., .c.._o.-..-| bus operations with a substantial deficit—as well as
enhancing public transit accessibility through decreased trip costs. The purpose of this paper is
to provide an overview of the impacts of introducing autonomous buses and taxis on
metropolitan transportation systems by quantifying the costs of travel in Japan, and to discuss
the potential benefits. First, this study sets the assumptions on autonomous driving
technology, including its impacts on vehicle costs, the decreased labor costs for driving and
safety monitoring in buses and taxis, and decreased driving stress for private car users. Next,
operating costs are computed for autonomous buses and taxis in Japanese metropolitan areas.
The costs of travel, or the sum of monetary and time costs, are then computed with and
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"Kod sistemi”nde (“Code System”) “REFERANSLAR" (“REFERENCES") baslgiyla bir kod ve bu kodun al-
tinda “RIS” ve "ANAHTAR KELIMELER” ("KEYWORDS") olmak tizere iki alt kod olusturulur. “RIS” kodu,
ice aktarilan dosyalarda kullanilan, érnegin, “Referans Tipi” (“Type of reference”) veya “Ozet” (“Abst-
ract”) gibi RIS etiketlerini alt kod olarak icerir. “ANAHTAR KELIMELER” (“KEYWORDS") kodu literattr
referanslarindaki tim anahtar kelimeleri alt kod olarak listeler.

ice aktarma islemi sirasinda, tim referanslar otomatik olarak her bir metin boltimu ile ilgili RIS koduna
uygun olacak sekilde kodlanir.

LiteratUr referansindaki her anahtar kelime kod sistemi icinde ilgili anahtar kelime ile kodlanir.

DOl linkleri hyperlink olarak metinlere eklenir. Béylece, ilgili yayinin cevirimici versiyonuna direk olarak
ulasmaniz, gerektiginde, mimkunddr.

Eger eklentiler iceri aktariimissa, ayni zamanda su islemler gerceklesir:

"“Belge Sistemi” icinde “"REFERANSLAR > EKLER" (“REFERENCES > ATTACHMENTS") seklinde bir belge
grubu olusturulur.

Tum ekler bu belge grubu icine ayri ayr belgeler olarak ice aktarilir.

Belgelere verilen dosya adlari korunur ve ilgili referanslar alfabetik olarak yukari dogru siralanir. Belge
isimlerinin siralanmasi bu nedenle tam olarak alfabetik olmasa da ayni belge isimleri birkag kez ortaya
cikabilir; 6rnegin, birden fazla belgenin “icindekiler” bolimu bulundurmasi durumunda oldugu gibi.

Ve eger referanslar ve ekler ice aktarilirsa:

Referanslar ile ekler arasinda i¢ baglantilar ek olarak olusturulur. Béylece, ilgili belge ve literatur referansi
arasinda baglanti kurulmus olur. Bu baglantinin kullanicilar icin avantaji literatdr referansi ile tam metin
arasindaki gidis gelisleri kolaylastirmak ve bunu sadece bir tik ile gerceklestirmektir. Literatr referan-
sinda, kurulan ic baglantiya “PDF linki (L1)” [“Link to PDF (L1)"] bélumUunden ulasilabilir (isimler RIS for-
matindan gelir ve ayni zamanda PDF disindaki formatlarda olan dosyalara da uygulanir). Ekte, i¢ baglanti
belgenin basinda yer alir.
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Bununla birlikte, kullanicilarin gelecek secimleri icin nemli olabilecek bes cesit bilgi, belge degiskenleri olarak

kayit edilir:

Bu degiskenler sistem degiskenleri olarak olusturulur ve kullanici tarafindan degisken tirl degistirilemez.

RIS_Type (Referans tipi) — metin degisken

RIS_Author (ilk yazar) — metin degisken
RIS_Title (Baslik) — metin degisken
RIS_Reference-ID (Kimlik numarasi) — tamsayi degisken

RIS_Year (Yayin yili) — tamsay degisken

Data editor - All documents

PoryoDprororomrR

BL 3
Document group
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS
REFERENCES
REFERENCES > ATTACHMENTS

Document Variables

2@

Document name
Abe, Ryosuke - 2019

Abe - 2019 - Introducing autonomous ...

Baumann, Martina F. et al. - 2019

Baumann et al. - 2019 - Taking respons...

Blyth, Pascale-L. - 2019

Blyth - 2019 - Of Cyberliberation and F...

Botello, Bryan et al. - 2019

Botello et al. - 2019 - Planning for walki...

Elgharbawy, M. et al. - 2019

Elgharbawy et al. - 2019 - Adaptive fun...

Janssen, Christian P. et al. - 2019

Janssen et al. - 2019 - Interrupted by ...

Her bir belge icin ice aktanlan degisken degerleri

RIS_Type RIS_Author

JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR
JOUR

Abe, Ryosuke
Abe, Ryosuke

Baumann, M...
Baumann, M...
Blyth, Pascal...
Blyth, Pascal...
Botello, Brya...
Botello, Brya...
Elgharbawy, ...
Elgharbawy;, ...
Janssen, Chr...
Janssen, Chr...

MAXQDA ile Literattr Taramasi

20 Documents

H6> 0
RIS_Title RIS_Year
Introducing autonomous buses a... 2.019
Introducing autonomous buses a... 2.019
Taking responsibility: A responsi... 2.019
Taking responsibility: A responsi... 2.019
Of Cyberliberation and Forbidde... 2.019
Of Cyberliberation and Forbidde... 2.019
Planning for walking and cycling i... 2.019
Planning for walking and cycling i... 2.019
Adaptive functional testing for au... 2.019
Adaptive functional testing for au... 2.019
Interrupted by my car? Implicatio... 2.019
Interrupted by my car? Implicatio... 2.019
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Literatir verisi ile calisma

ice aktarma ve otomatik 6n-kodlamay takiben, MAXQDA programinda bibliyografik veriye normal metin
olarak erisilebilir. Bu demektir ki ilgili veri aranabilir, kodlanabilir, ilgili oldugu belgelerle baglanti kurulabilir,
dlzenlenebilir ve dahasi memolar eklenerek sonraki nitel ve nicel analiz streclerine hazirlanabilir (Kuckartz &
Radiker, 2019). Boylece, su sorulari cevaplayabilirsiniz:

Bazi yazarlarin ismi ne siklikla referanslarda gegmektedir?
Hangi konular ele alinmigtir?
Belirli konulardaki ydnelimler nasil degismistir?

Daha cok dergi makaleleri mi yoksa belirli bir konuya odaklanan tekyazilar (monograf) mi bulunmakta-
dir?

Dergi makalelerinin basliklari zamanla ne 8l¢lide degisim gostermistir?

Analizinize baslamaniz icin size Uc ayri fikir 6rnegi verelim:

1.

Kod sisteminde yer alan anahtar kelimelerden birine farenin sag tusuyla tiklayiniz ve Activate Documents
Containing this Code (Bu Kodu iceren Belgeleri Etkinlestir) fonksiyonunu seciniz. MAXQDA programi
daha sonra bu anahtar kelimenin atandigi tim ilgili literatUr kayitlarini ve eklerini aktive edecektir.

“Coded Segments” (“Kodlanmis bolumler”) fonksiyonu ile tim 6zetleri acabilmek icin “RIS > Abstract”
(“RIS > Ozet"”) secenegine cift tiklayiniz. Smart Coding Tool (Akilli Kodlama Araci) fonksiyonunu ézetleri
kodlamak ve sistematize etmek icin ara¢ cubugunda yer alan ayni isimdeki sembole tiklayarak baslatiniz.

“Geri Cagnlan Bélumler” penceresinde tim bagliklari listelemek icin “REFERENCES” (“REFERANSLAR")
belge grubunu ve “RIS > Title” (“RIS > Baslk") kodunu aktive ediniz. “Geri Cagrilan BélUmler” pencere-
sinde Word Cloud (Kelime Bulutu) semboline tiklayarak basliklarda yer alan (en yaygin) kelimelerin anali-
zine baslayiniz.
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MAXQDA ile literatiuiriin ve ozetlerin diizenlenmesi ve analizi
edilmesi

LiteratUr Uzerinde — hem cevrimici hem ¢evrimdisi — calismak arastirma ve dgretim alanlarinda oldugu gibi sivil
toplum 6rgutleri ve enstitller diizeyinde piyasa arastirmalari amaciyla yUritdlen en énemli aktivitelerden biri-
dir. Literatdr calismalarinda tipik gérevler konu ile ilgili yayinlari bulmak ve okumak, énemli noktalar belirle-
mek ve isaretlemek, arglimanlar anlamak ve metinleri disa aktarmak ile bunlari bir araya getirmek ve karsi-
lastirmaktan olusmaktadir. MAXQDA programi bu tir gtinlik goérevler ve islemler icin mikemmel bir aractir.
Yaptiklar blog paylasimlarinda, Elgen Sauerborn (2014) ve Uta-Kristina Meyer (2014), arastirmalari icin ilgili
literatUrt okurken, &zetleri ve notlari nasil olusturduklarini ve onlari MAXQDA programini kullanarak nasil
organize ettiklerini agiklamaktadir. Onlarin yaptig calismalara ve bizim deneyimlerimize dayanarak, su asama-
lari &neriyoruz:

1. MdmkUn oldugunca, arastirmada kullanilacak olan erisilebilir tim literattr kaynaklari MAXQDA projenize
aktarilir.

2. MAXQDA programi icinde her bir belge icin ayr ayn 6zetler olusturulur. Bu dosyalarda referans bilgileri
(yazar, yil, baslk) belge adi olarak kullanilir ve ideal olarak daha sonra bibliyografide tercih edilecek ayni
referans stili kullanilir. Boylece, yazarlar “Belge Sistemi”nde (“Document System”) kolayca belge adlari
ile aranabilir.

3. Belge icindeki memolarda, kaynaklar ile ilgili daha fazla bilgi (belirli argimanlardan dogan sorular, bazi
yayinlarin elestirileri veya kaynagin sizin calismaniz icin uygun olup olmamasi gibi) yénetilebilir.

4. "Kod Sistemi” (“Code System”) raporu takip eden bélimler ile kodlar ve onlarin ayni sirali haliyle olustu-
rulur. Ozetler ve atif icin uygun olan orijinal belgelerin bélimleri bu kodlarla kodlanacaktir.

5. Rapor yazildiginda, ilgili kodlar aktive edilir ve béylece tim kodlanmis bélumler “Geri Cagrilan Bélumler”
(“Retrieved Segments”) penceresinde bir araya getirilir.

6. Temel amag, yazmayi kolaylastirmak ve édnemli noktalari ya da referanslari kacirma riskini ortadan kaldir-
maktir. Boylece, MAXQDA kullanicinin “yazma” eylemine odaklanmasina yardimci olur.

7. islem tamamladiktan sonra, kaynaklar, 6zetler, notlar ve kodlanmig bolumler kullanicinin erisimine acik
olarak kalir. ilerleyen zamanlarda benzer bir konu tzerinde calisirken, halihazirda elinizde olan bu doku-
manlar diger referanslari ve 6zetleri yeni olusturacaginiz calisma icin kullanmaya temel olusturur.
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MAXQDA ile literatiir taramalarinin olusturulmasi

“LiteratUr taramasi” ne demektir? Arlene Fink'e gore, “Bir arastirma igin literatlr taramasi sistematik, acik, ve
tekrar edilebilir bir metot uygulanarak arastirmacilar, uzmanlar ve uygulayicilar tarafindan kaydedilmis ve
olusturulmus bilgiler butindnU belirlemek, degerlendirmek ve bir araya getirmektir” (Fink, 2010, p. 3).

Bu sekilde aciklandiginda bir literatlr taramasi belirli bir konu veya arastirma sorusuna acgiklik getirmek icin
yaratalur. Amacg, belirli bir alanda ve konuda stregelen bilimsel tartismalarin mevcut durumunu ortaya koy-
maktir. Bununla birlikte, literatlr taramasinda bir konunun énceden belirlenmis farkli yénlerine de odaklani-
labilir. Ornegin, bir konu ile ilgili metodolojik calismalari veya teorik temelleri ele almak gibi. Bir literatiir tara-
masi, bir cesit ikincil analizi temsil eder. Yeni ve bagimsiz bir arastirma olmasindan ziyade, bir alanda caligilmis
bir konunun 6zel bir kapsamda incelenmesidir. Bir literatlr tarama calismasi, bir deneme yazisi gibi genelde
tek bir arastirmaci tarafindan yazilan bir incelemedir. Sistematik olarak konu ile ilgili arastirma sonugclarini su-
nar; konuya iliskin farkli bakis acilarini belirler; ve spesifik bir alanda yapilmis calismalari analiz ederek 6zetler.
Bir literatUr taramasi, basit sekilde kaynaklarin listesi olmaktan ziyade her zaman aciklayici bir metindir.

LiteratUr taramalari gesitli bilimsel arastirmalarin bir parcasi (bir doktora tezi veya arastirma raporu gibi) ya da
bash basina bir inceleme seklinde olusturulabilir. Bash basina bir inceleme seklinde olmasi halinde literatdr
taramalan “sistematik incelemeler” olarak adlandirilir. Sistematik incelemeler her zaman belirli bir konuya ya
da problem durumuna odaklanir ve ilgili alanyazindaki bosluklari belirlemeyi amaclar. Bilimsel arastirmalarin
bir parcasi olan calismalarda bdyle bir amag baskin olmamakla birlikte bu literatlr taramalarinin sistematik
olmadigi ya da eklektik (secmeli) oldugu anlamina gelmez. Bununla birlikte, geleneksel olarak, basli basina bir
inceleme formatinda yapilan calismalar daha cok nicel yonlere odaklanir.

Literatiir taramasi olustururken takip edilecek asamalar

Fink (2019), Boland ve digerleri (2017), Hart (2017), Gough ve digerleri (2017) ve Heyvaert ve digerlerinin
(2016) yapmis olduklar calismalar 1siginda, bir literattr taramasinin olusturulmasi icin alti asamanin takip edil-
mesi gerektigi sdylenebilir:

1. Arastirma sorularinin olusturulmasi ve literattr taramasinin amaclarinin belirlenmesi. ilgili arastirma so-
rusu literatlr taramasini etkin sekilde yUrttebilmek igin tam olarak olusturulmalidir.

2. GUnUmuzde genel olarak gevrimici olan bibliyografik veri tabanlarinin secilmesi.
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3. Bu veri tabanlarinda arama yapmak icin kullanilacak anahtar kelimelerin belirlenmesi.
4. Uygulama ve yontem ile ilgili kriterlerin nitelikli bilimsel literattrtn secilmesi icin uygulanmasi.

5. incelemenin yUratulmesi. Bu asama bircok adimi kapsamaktadir: Bibliyografik verilerin ve devaminda tam
metinlerin ice aktariimasi; yazar, yayin yili gibi degiskenlerin tanimlanmasi; &nemli metin bélumlerinin te-
matik olarak kodlanmasi, notlarin ve &zetlerin yazilmasi.

6. Sonuclarin sentezlenmesi ve incelemenin yazilmasi. Bu asamada sonuclar, nitel tanimlar formunda veya
nicel meta-analiz uygulanmasi durumunda istatistiksel karakteristik degerlerin ve élcimlerin hesaplan-
masi yoluyla sunulabilir.

MAXQDA programi tim asamalarda, 6zellikle 5. ve 6. Asamalarda belirtilen temel kaynaklarin icerik ve tema-
tik analizlerinin gelistirilmesinde, kullanicilara &nemli destekler sunar. Bu tip bir ¢calisma icin MAXQDA progra-
minin sundugu farkl olanaklari tanitmadan énce, MAXQDA programi ile Endnote, Citavi, Mendeley, Zotero
gibi referans yonetim programlari arasindaki farkliliklar géz 6ntinde bulundurulmalidir. Endnote ve benzeri
programlar, temel cevrimici ve cevrimdisi kaynaklarin referanslarinin bir araya getirilmesi, yonetimi ve atifi

gibi islemlere olanak tanir. Bu programlarin temel odag: bibliyografik girdinin ve bibliyografilerin blytk sayida
bilimsel dergi ve yayinevinin farkli kurallarina uygun olarak olusturulmasi ve yonetilmesidir. Ornegin, oldukca
yaygin kullanilan programlardan biri olan Zotero programi (www.zotero.org) cevrimici kataloglardan ve Ama-
zon gibi kitap satiscilarinin veri tabanlarinda bibliyografik bilgileri arar ve bu bilgilerin lokal veri tabaninda
saklanmasini ve meta veri olarak anahtar kavramlar (arama kavramlari) ile kaydedilmesini mimkdan kilar. Re-
ferans listeleri daha sonra farkli alintilama stillerine (6rnegin, oldukca yaygin kullanilan APA stili gibi) donUsta-
rUlerek disari aktarilabilir. Referans yénetim programlar bibliyografik verilere odaklanirken, MAXQDA prog-
rami icerige odaklanarak tematik ve sistematik kodlamaya ve icerigin nitel ve nicel olarak kodlanmasina ola-
nak tanir. Bu nedenle, MAXQDA programi bibliyografik verilerin toplanmasi icin kullanilan temel programlar-
dan birisi olmadigi gibi (ki istenirse bu mimkunddr) yayinlar icin referans listelerini olusturma amaci da tasi-
mamaktadir. Fakat, daha 6nce de belirtildigi Gzere, MAXQDA programi kullanicilara, referans yonetim prog-
ramlarindan bibliyografik verilerin iceri aktarilmasi imkanini verir.

Simdi, MAXQDA programi ile literatlr incelemesi olusturma asamalarinin tanimina dénelim. Literatdr incele-
meleri sadece belirli bir alandaki mevcut bilginin durumunu sergilemek acisindan degil, ayni zamanda ilgili
arastirma konusunun daha genis baglamda ve bilimsel ¢cevrelerdeki tartismalar icinde yer edinmesi acisindan
blydk 6nem tagimaktadir. Bir literattr incelemesi olusturmanin alti asamasi detayli olarak asagida sunulmak-
tadir.
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1. Asama: Literatlr taramasi icin arastirma sorularinin ve amacin olusturulmasi

Tdm arastirma projelerinde oldugu gibi, bir literatlr taramasi da arastirma alaninin, sorularinin ve amaclarinin
olusturulmasi ile baslar. Bununla birlikte, arastirma sorusunun olusturulmasi bir arastirma projesine kiyasla
daha genis bir kapsamda ele alinmaktadir. Eger incelemenin odagi oldukca sinirli ise, arastirma konusunun
odaginda yer alan fakat ilk etapta arama sonucunda ortaya ¢ikmayan ilgili kaynaklar gézden kacabilir.
MAXQDA programinda, arastirma sorusu ve amaclari, en iyi ve etkin olarak serbest memolar (Memolar >
Serbest memo - via Analysis > Free Memo) formunda sunulur. Ornegin:

Memo baghgi: Karma yontemler arastirmasinda veri analizi ve entegrasyon (birlestirme) Gzerine literatdr in-
celemesi

Bu literatdr incelemesinin amaci karma yéntemler arastirmasi alaninda veri analizi ve entegrasyon (birlestirme)
konularindaki tartismalarin mevcut durumunu degerlendirmektir. Karma yéntemler arastirmasi alaninda cok iyi
taninan yazarlar, nicel ve nitelin birlestirilmesini (entegrasyonunu) karma ydntemler arastirmasinin temel zor-
luklarindan biri olarak gérmektedirler. Bu inceleme, bu konudaki en 6nemli degerlendirmeleri bir araya getir-
meyi amaclamaktadir. Karma yontemler arastirmasi soylemi ingilizce olarak yUrtttldugi icin, sadece ingilizce
dilinde yayinlanmis olan literatlr dikkate alinmalidir. Bu inceleme, 2014-2016 yillarini kapsayacak ve karma
yontemler arastirmasi alaninin lider dergisi olan Journal of Mixed Methods Research ile sinirli olacaktir.

2. Asama: Bibliyografik veritabanlarinin secimi

Bir sonraki adim, ele alinan konuyla ilgili soruya cevap sunabilecek kaynaklari belirlemeye yénelik hedefe da-
yali bir arama yapmaktir. Geleneksel bir kitiphanede, literatir anahtar kelimeler ve anahtar kelime katalog-
lari ile belirlenir, raftan alinir, ve daha sonra calisma alanina veya masaya getirilir. Bilgisayarlarla calisirken ve
dogru veritabanlarinda arama yaparken, ayni prensip gegerlidir. Arastirmaci veritabanlarini ve bilimsel dergi-

leri kesfeder, arama sonucunda elde edilen kaynaklar listesini ve literatlr taramasina katki saglayacagini du-

sUndUgu ve sectigi kaynaklari kaydeder.

Daha sonra, nereye ve neye bakilacagina karar vermek dnemlidir. Bir diger deyisle, anahtar arama kelimelerini
belirlemek ve bibliyografik veritabanlarini se¢mek bir sonraki adimi olusturur. Genel olarak veritabanlari cevri-
micidir ve kamu kurumlari ile 6zel kurumlar tarafindan sunulan yUzlerce veri tabani mevcuttur.
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En popduler uluslararasi veritabanlari sunlardir: PubMed (Tip), MEDLINE (Tip), ERIC (Egitim bilimleri), JSTOR
(bircok disiplin), LexisNexis (ekonomi ve hukuk), PsycINFO (Psikoloji), Social Science Citation Index and Socio-
logical Abstracts (sosyal bilimler — veri tabaninin original adi korunmustur) (Fink, 2019, pp. 17-21). Ayni za-
manda Springerlink gibi 6zel veri tabanlarinin, Springer International Publishing AG gibi portallarin, Sage Ya-
yinlar gibi dergi ve periyodik yayinlarin yer aldigi metot ve metodoloji alanlarinda vazgecilmez veritabanlarini
belirtmekte fayda vardir. Bunun &tesinde dustnulmesi gereken bir diger Gnemli nokta ise sadece ingilizce di-
lindeki kaynaklarin aramaya dahil edilmesi kararidir.

3. Asama: Anahtar arama kelimelerinin belirlenmesi

Buraya kadar bahsedilen adimlardan sonraki asama ise anahtar arama kelimelerinin belirlenmesidir. Bu kav-
ramlar tek bir kelime olabilecegi gibi birden fazla kelimenin kombinasyonu da olabilir. Neredeyse tim verita-
banlar gelismis arama 6zelligi sunmakta ve arastirmacilara daha karmasik kosullari, drnegin ilgili anahtar keli-
meleri VE ve VEYA mantik islecleri ile belirtme imkani sunmaktadir.

Ornek: Journal of Mixed Methods Research (JMMR) dergisinde, “veri analizi” (“data analysis”) temasi ile ilgili
tdm kayitlar icin bir arama yapilir. Arama 2014-2016 yillari ile sinirlandirilir. Diger muhtemel anahtar kelimeler
“veri cesitlemesi” (“triangulation”) ve “birlestirme” (“integration”) olabilir. Ancak buradaki 6rnekte, arama
“veri analizi” ile sinirhdir. JIMMR web sitesindeki (https://mmr.sagepub.com/search) arama 57 bulgu ile sonugc-
lanir.

Bir sonraki asamada, websitesinde ortaya cikan sonuclarin uygunlugu yine site Uzerinde kontrol edilebilir veya
arama sonunda elde edilen sonuclarin tam listesi MAXQDA programina aktarilarak orada kontrol edilebilir. Bu
ornekte, MAXQDA programina sonuclarin aktarilarak kontrol edilmesi daha etkin bir yoldur. Sage Yayinlari
websitesinden disa aktarirken dikkat edilmesi gereken en 6nemli husus hem referansin hem de calisma dzetinin
disa aktarldigindan emin olmaktir. RIS formati mevcut formatlar listesinden secilmelidir. ilgili dosya, MAXQDA
programina menude yer alan iceri aktar > Referans Yonetici Verisi (Import > Reference Manager Data) fonksi-
yonu ile aktanhr.

4. Asama: Nitelikli bilimsel literatlrin secimi icin uygulama ve yontem ile ilgili kriterlerin uygulanmasi

Bu asama ilgili literatlrtin segimine dnem vermeyi gerektirir. Bir diger deyisle, veri tabani aramasinda bulunan
literatlr bu asamada 6zel olarak arastirma sorusunun daha dar bir alanina mi karsilik geliyor yoksa mevcut
haliyle literatUr incelemesinin tim amaclarini karsiliyor mu sorularina cevap aramayi amaglar.
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Bu secim sirecinin uygulama ve yontem ile ilgili kriterleri mutlaka kayit altina alinmalidir. Uygulama ile ilgili
kriterler pratik erisilebilirlik, dil ve yayin tipi ile ilgilidir. Ornegin, Avrupa’da cevresel farkindalik ile ilgili bir ca-
lisma icin, sadece bircok yaygin dilde sonuclar, muhtemelen sadece ingilizce olanlar, dustintlebilir. Dahasi,
arama sadece en 6nemli sosyal bilimler dergileri ile sinirlandirilabilir. Bu tarama icin yontem ile ilgili kriterler,
drnegin, drneklemin kalitesi ve bicimi ya da ilgili calismayi yUrlten enstitinun “ciddiyeti” ile ilgili olabilir. Y6n-
tem ile ilgili gerekceler arasinda cevrimici anketlere dayali kaynaklarin dahil edilmemesi yer alabilir. Bunun
nedeni olarak da kolay ulasilabilir durum &rneklemesi ile veri toplanmis olmasi gdsterilebilir.

Daha 6nce verilen karma ydntemler arastirmasi érneginde veri analizinin literatlr incelemesi érnegi icin, tim
bibliyografik arama sonuclari MAXQDA programinda ice aktarilmisti. Boylece kaynaklarin “Belge Sistemi”

("Document System”) kisminda listelenmesi mimkin hale gelir. Asagida yer alan gorsel, MAXQDA progra-
minin bu bilgiler ice aktarildiktan sonra nasil gériinddgind gdstermektedir.
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RIS format etiketleri “Kod Sistemi”nde (“Code System”) bulunabilir. Buradaki 6rnekte goruldigu Gzere top-
lam 57 kaynaktan sadece 49'u icin 6zet bulunmaktadir. Belge degiskenleri listesinin (the list of document va-
riables) goruldigu sag taraftaki pencerede bes etiketin (yayin tird [type of publication], yazar [author], baslik
[title], kayit numarasi [ID], yayin yili [year of publication]) ayni zamanda degisken olarak sonraki secimler icin
mevcut oldugu gortlmektedir.

Bir sonraki adim, kaynagin literatir taramasina uygun olup olmadigini belirlemek icin sistematik olarak her
Ozeti okumaktir. “Belge Sistemi” (“Document System”) icinde iki veya daha fazla yeni belge grubu olusturul-
masi, elde edilen sonuclarin ilgili olup olmadigina gére dizenlenebilmesi icin dnerilir. Belge gruplarinin isim-
leri islevlerini ifade etmelidir. Ornegin, “Uygun kaynaklar” ve “Az uygun kaynaklar” gibi. ilgili literatdr tara-
masina katkida bulunmayan kaynaklar hemen silinebilir. Ozetleri okurken bir kaynagin nereye atanacagina
iliskin emin olunamiyorsa, tam metinler ilgili linkteki “DO_DOI" etiketi veya “UR_Web/URL" etiketi ile olustu-
rulmus kodlara tiklanarak “Belge Tarayici”sindan erisilebilir. Bu link Sage Yayinlari veri tabaninda yer alan ve
tam metne yonlendiren bilgi sayfasini acacaktir (veri tabanina kitiphaneniz araciligiyla erisiminizin oldugunu
varsayiyoruz). Tam metni okumak ilgili kaynagin uygun veya az uygun kaynak olup olmadigina iliskin siniflan-
dirmayi yapmak adina saglam dayanaklar gelistirmeyi mdmkan kilar.

Kullaniciya secim yapma veya karsilastirma olanagi saglayan ve trendleri farketmesini saglayan diger degisken-
ler literattir taramasinin bu asamasinda tanimlanir. Ornegin, “RIS_Year” (“RIS_Yil”) degiskeni, kaynaklarin yila
godre dagilimini gésteren bir tablo veya cizelge olusturulmasina olanak tanir.

Veri tabani taramasi ile elde edilen sonuglarin yani sira literatlr taramasina dahil edilmesi gereken bagka te-
mel kaynaklar olabilir. Prensipte, tim kaynak tdrleri, ses ve video kayitlari dahil, MAXQDA programinda ice
aktanlabilir. Kitaplar gibi 6ding alinamayan kaynaklar sadece taranmis kopyalar olarak erisime acik olabilir.
Boylesi arama yoluyla taranmis kaynaklar da literatlir taramasina dahil edilebilir.

Taranmis kaynaklar icin ipuclari: Uygun bir kaynagin elektronik versiyonu erisime acik degilse, tek secenek
taranmis sayfalari kullanmaktir. Tarama islemi ile bir PDF veya fotograf dosyasi elde edersiniz. Adobe Acrobat
gibi bir programi kullanarak, optik karakter tanima (OCR) metin algilama prosedtrint uygulayabilirsiniz. Bu
adim énemle tavsiye edilir ctinkti devaminda yapilacak olan aramalar, MAXDictio dahil olmak Gzere MAXQDA

programinda yer alan metin icinde kelimeler veya tim kelime fonksiyonlarinin gerceklestirilebilmesi icin dnem-
lidlir.
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Eger kaynaklar uygunluklarina gére siniflandiriimigsa, ézellikle uygun olan kaynaklar tam metin olarak ice ak-
tarlabilir. Yeni belge grubu (6rnegin, “Temel literatlr” gibi) olusturmak ve tam metinleri indirip bu dosyaya
kaydetmek en iyi uygulamadir. ideal olarak, tam metin ve bibliyografik referans su adimlarla iliskilendirilmeli-
dir:

1. Tam metni aciniz.

2. Bibliyografik referansi “ikinci Belge Tarayicisi“nda (“Second Document Browser"”) aginiz.

3. Tam metinde ilk kelimeyi (veya ilk paragrafi) vurgulayiniz ve Dahili Baglanti Ekle (Insert Internal Link) fon-
ksiyonunu icerik menUsinden seginiz.

4. Bibliyografik referansta ilk kelimeyi (veya ilk paragrafi) vurgulayiniz ve Dahili Baglanti Ekle (Insert Internal
Link) fonksiyonunu icerik mentstinden seciniz.

Basta ¢zel veri tabanlari olmak Uzere bircok veri tabani icin, indirme islemi sadece gerekli yetkiye sahip olma-
niz halinde s6z konusu olabilir. Bircok Universitede bu olanak mevcuttur ve dniversitenin tim Gyeleri icin bu
kaynaklar erisime acik olabilir. Universite agi tizerinden VPN ile giris yapmak gerekebilir.

5. Asama: incelemeyi yiritme

Bir literatUr taramasini ydrtme sdreci aragtirma sorularinin dogasina, incelemenin amaclarina ve kaynaklarin
cesitliligine bagl olarak farkllik gosterebilmektedir. Bununla birlikte, strec, literattr taramasinin hazirligr igin
sahip olunan zaman dilimine de baglidir. Eger zaman kisitl ise, materyali sinirlandirmak ve uygulama ve yon-
tem ile ilgili kriterlerin olusturulmasini sinirlandirmak zorunda kalirsiniz (Asama 4'e bakiniz). Bu durumda, ta-
ramaniz detayli tam metinlere degil, 6zetlere dayali olacaktir. Bahsedecegimiz secenekler MAXQDA programi-
nin literatlr taramasi yUrttebilmek icin dnerdigi olasi yollardan birkagidir:

Kelime bulutlari ile calismak

Bir metnin ve kullanilan anahtar kelimelerin merkezinde olusan temalar nelerdir? Bunlar, kolaylikla tam me-
tinde sag tiklayip Kelime Bulutu (Word Cloud ) secenegini kullanarak kesfedilebilir. Alternatif olarak, bibliyog-
rafik verinin belirli kisimlari (basliklar veya 6zetler) icin ilgili bolimleri geri cagirarak ve “Geri Cagrilan Bolim-
ler” (“Retrieved Segments”) penceresindeki kelime bulutu fonksiyonunu kullanarak bir kelime bulutu olustu-
rabilirsiniz. Anlamsiz kelimeler veya literatlr taramasi kapsaminda ilgili olmayan kelimeler haric listesine ekle-
nebilir.
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Tam metni inceleme ve memolarla calisma

Hemen hemen her konuda erisime agik yayinlarin cok sayida oldugu goéristiinden hareketle, bir kitabin ya da
dergide yayinlanmis makalenin tamamini okumak ¢ogunlukla glctur. “Belge Tarayicisi” (“Document
Browser") icinde icerik arama ¢zelligini kullanarak, anahtar kelimelerin ilgili metinde olup olmama durumunu
6zel olarak arayabilirsiniz. Bu arama, detayli okuma gerektiren yogun metinleri ciddi miktarda azaltma islevi
gordr. Fikirler ve temel varsayimlarin yaninda ortaya ¢ikan sorular, daha sonra memo olarak ilgili metinlere
eklenebilir. Bir metnin genel degerlendirme ve elestirilmesi belge memolari olarak “Belge Sistemi” (“Docu-
ment System”) icinde kayit altina alinabilir.

Metinlerdeki énemli kisimlari vurgulama

Bir metni okumak ve dnemli noktalarin altini cizmek yaygin olarak kullanilan bir uygulamadir. MAXQDA
programini kullanarak literattr taramalarinda ayni yaklasimi uygulamak mumkundir. MAXQDA, kullanicilara
metin verilerini renkli kodlayabilmek icin beg farkli renk secenegi sunmaktadir. isaretlenmis olan béltimlere
daha sonraki bir zaman diliminde kolaylikla erisilebilir. Bazi durumlarda, metinleri renkli kodlamadan ziyade
tematik kodlamak daha faydali olabilir.

Kaynaklarda kullanilan kavramlarin ve kelimelerin frekanslarini (kullanim sikliklarini) inceleme

Sozclk frekansi fonksiyonunu (MAXDictio sekmesinin bir ézelligi) kullanarak bir veya daha fazla belge icinde
gecen kelimelerin frekanslarini analiz edebilirsiniz. Bununla birlikte, farklilastirilmig bir kelimenin frekans ana-
lizi de belgelerde, belge gruplarinda ve kimelerde gerceklestirilebilir. Kelime bulutlarinda oldugu gibi, anlam-
siz kelimeler haric listesine eklenerek analiz disi birakilabilir.

Ozetleri yazma

Metin 6zetleme ve ilging metinleri disa aktarma literatlr taramasinin en klasik tekniklerinden biridir.
MAXQDA programinda, “Ozetler” adinda bir belge grubu tiim 6zetlerdeki ve belgelerdeki alintilarin kayit
edilebilmesi icin 6ncelikle tanimlanmalidir. Daha sonra, Yeni Metin Belgesi (New Text Document) belge sis-
temi icinde belge grubu mendstnden sag tiklayarak secilir. Boylelikle, icerisine &zetleri yazmaya baslayabile-
ceginiz yeni bir belge “Belge Tarayicisi” (“Document Browser”) alaninda dizenleme modunda olusturulacak-
tir. Eger tam metin ice aktarilmissa, tam metin “Belgeyi ikinci Belge Tarayicisinda A¢” (“Second Document
Browser”) secenegi kullanilarak ikinci bir tarayicida agilabilir. Bu fonksiyon, kullanicinin es zamanli olarak hem



MAXQDA ile LiteratUr Taramasi 23

kaynak metni okumasi hem de 6zeti yazmasina olanak tanir. Belge linkleri kullanilarak metnin belirli bir bo-
lum ile ilgili 6zet birbirlerine baglanabilir. Ozetin adlandirnlmasi sirasinda yazara ve yayin yilina yer verilmeli
ve dahasi 6zet, daha 6nce belirtilen asamalar takip edilerek bibliyografik referansa baglanmalidir.

Metin bolimlerinin otomatik kodlanmasi

Metin ilging anahtar kelimeler icin aranabilir ve elde edilen sonuglar otomatik olarak Analiz > Sézctiksel
Arama (Analysis > Lexical search) fonksiyonu kullanilarak kodlanabilir. Kodlanacak olan metinlerin cesitliligi
kullanici tarafindan serbest sekilde (arama sonuclari, ciimle, birkag cimle, paragraf) secilebilir. Otomatik kod-
lamayi takiben, kodlanmig béltmler cagrilip daha detayli kesfedilebilir.

Onemli metinlerin manuel/elle tematik kodlanmasi

ilgili metinlerin kodlanmasi ana metin (dergi makalesi) erisime acik oldugunda mumkundur. Bu durumda, in-
celeme kapsamindaki arastirma sorularina miimkdn oldugunca en yakin tematik kodlarla calismak tavsiye
edilir. Ozel etiketleme sayesinde, daha sonra alinti yapmaya uygun olan metinleri etiketleyebilirsiniz. Bu amac
icin, 6zel bir kod (6rnegin “Alintilama icin uygun”) tanimlanabilir. Alternatif olarak, yorum fonksiyonu veya
agirlik skoru kullanilabilir. Her bir kodlanmis balim igin, kisa bir yorum (bu durumda, érnegin, “Alinti”) ekle-
nebilir. Daha sonra, Kodlu Bélimlere Genel Bakis (Overview of Coded Segments) bélimiinden (Raporlar me-
nistnde yer alir) tdm muhtemel alintilarin bir arada yer aldigi situna gdére siralama yapabilirsiniz. Ayni za-
manda, kodlanmis herhangi bir bélime bir agirlik skoru atamak mimkinddr. Ardindan, secilen temanin veya
spesifik agirlik skoru atanan kodlanmis metinleri geri cagirabilirsiniz.

Farkli boyutlari ayirt etme, kodlama ve istatistiksel olarak analiz etme

Literattrdeki spesifik bir icerik alani icin, (6rnegin arastirma deseni) spesifik boyutlar alt kodlar olarak tanimla-
nabilir. Ornek verecek olursak “Aciklayici sirali desen” (Explanatory sequential design), “Kesfedici sirali de-
sen” (Exploratory sequential design) veya “Eszamanli desen” (Convergent design) gibi. “Kodlar” menisinde
yer alan Alt Kodlarin Istatistigi (Subcode Statistics) secenegini kullanarak farkli desen tiplerinin frekanslarinin
belirlenmesi ve tablo veya grafik olarak gosterilmesi mumkun olabilir.
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Temalarin ve kaynaklarin gorsel sunumu

MAXQDA programinin gérsel araclar literatUr taramalari icin de oldukga etkin sekilde kullanilabilir. Burada
ilgili metinlerin elle veya anahtar kelimeler Gzerinden otomatik kodlama &zelligi kullanilarak kodlandigini ka-
bul ediyoruz.

e Kod Matris Tarayicisi (Gorsel Araclar menUsi — Code Matrix Browser) kapsanan temalari ve her biri icin
kodlanmis metin frekanslarini karsilastirmali bir tablo ile sergiler.

e Kod iligkiler Tarayicisi (Gorsel Araclar menUst — Code Relations Browser) karsilastirmali bir tabloda grup-
lanan temalarin es zamanli ortaya ¢kma durumlarini sergiler.

e Yeni Belge Modeli (Tek Vaka Modeli — Single-Case Model) (Gérsel Araclar > MAXMaps/ Visual Tools >
MAXMaps mendstinde bulunur) kodlanmis temalari ve secilmis bir kaynak icin onlarin sikligini sematik bir
gorselle sunar.

e Yeni Kod Modeli (Tek Vaka Modeli — Single-Code Model) (Gérsel Araclar > MAXMaps menisunde bulu-
nur) secilmis tema, onun kodlanmis bélimleri, kodun memosu ve memonun atandig ilgili kodu sematik
olarak gorsellestirir.

Tematik dzetlerin yazilmasi ve 6zet tablolarinin olusturulmas

Bu teknik MAXQDA programinin Analiz > Ozet Kilavuzu (Analysis > Summary Grid) fonksiyonunu kullanir.
Bu fonksiyon temalarin olusturulmasini kolaylastinir ve onlari kargilastirmali tablolar halinde sunar (“Ozet Tab-
lolari”/"Summary Tables”). Bu teknigi kullanabilmek icin ilgili metinlerin dnceden tematik olarak kodlanmig
olmasi gereklidir.

Temalarin nicel degerlendirilmesi

Nicel yonler literatir taramasi icin énem tegkil edebilir. Ornegin, degiskenlere (6r., yayin yili) gére kaynaklari
saymak ve siralamak miamkunduar ve “ilgili kaynaklar zamanla nasil dagiim gostermistir?” veya “Veri analizi
ve birlestirilmesi konusuna yonelik calismalar ilgili zaman diliminde artmis veya azalmis midir?” sorularina ce-
vap verilebilir. istatistiksel tablolar bagil ve mutlak frekanslarin yani sira tematik kodlar ve alt kodlari icin cu-
buk grafik ve dairesel grafik seklinde MAXQDA programinda olusturulabilir. Korelasyon analizi gibi daha
kompleks analizler MAXQDA programinin STATS (istatistik) modUlU ile gerceklestirilebilir.
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6. Asama: Sonuclari sentezleme ve incelemeyi yazma

isin cogu ilk bes asamada tamamlandiktan sonra, bulgularinizi 6zetleme ve yorumlama zamanidir. inceleme-
nizi yazarken, ilk bes asama icin yapilan is ve énhazirlik &nem tasimaktadir. Bu demektir ki, yapilan 6n isten
elde edilen sonuglar sizi iyi organize edilmis bir metin yazmaya hazirlamalidir. Bir diger deyisle, asama 5 ve
6'da hazirlamis oldugunuz memolarin yani sira 6zet tablolarn gibi gorsel araclar g6z éntinde bulundurarak
yazma sUrecinizi baslatabilirsiniz.

iki tip literatdr taramasi vardir:
1. Sonuclarn nitel tanimi formunda bir inceleme (betimsel literatlr taramasi); nadiren nicel sonuclarin (6r.,

kaynaklarin sayisi, zamanla dagilimi, mevcut trendler, alt konularin frekansi gibi) da dahil edildigi 6rnekleri
mevcuttur. Ancak odagi her zaman niteldir.

2. istatistiksel parametrelerin ve dlceklerin hesaplandigi nicel meta-analiz formunda literatdr taramasi. Bu-
rada, bir etkinligin cesitli dizeylerindeki ortalama korelasyonlarinin hesaplandigi ve raporlandigi tutum-
davranis arastirmalarinin meta-analizi calismalarina benzer sekilde istatistiksel prosedirlerin sonuclarina
odaklanilir.

Fink’e (2019) gore, her iki literatlr taramasi tirl de su dort bdlimU icermelidir:

e Taramanin genel amaci ve hedefleri
e Metot ve 6rneklem

e Sonuclar

e Tartisma

Nicel meta-analiz calismalarinda, metot bdlimU kullanilan istatistiksel metotun detaylari ve tanimini kapsaya-
cak sekilde 6zel olarak genisletilmelidir.
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incelemenizi yazarken, asagida belirtilen MAXQDA araclari size blyUk 6lctide kolaylik saglayabilir:

e Sozclksel Arama ve Gelismis Kodlama Sorgusu (Simple and the Complex Coding Query): Bu iki 6zellik ile
onceden uygun alintilar icin etiketlenmis ve siniflandirilmis olan metinleri ve metin bolimlerini geri cagira-
bilirsiniz.

e Memolar (Memos): Ozellikle, incelemenin 5. asamasinda yazilmis olan serbest memolar son seklini vere-
ceginiz metne ilgili pasajlar ve metinleri kopyalama imkani sunar.

e Ozet Tablolan (Summary tables): Kaynaklar icin yogunlastirimis sekilde bir araya getirme, etkin olarak
karsilastirma ve sunma kolayligi saglamaktadir. Ayrica literatiir taramaniza 6zet tablolarini dahil etmeniz
bu fonksiyonu kullanarak mimkundar.

e MAXDictio icindeki kelime frekansi fonksiyonu: Bu 6zelligi kullanarak spesifik arama kelimelerinin ve an-
lamsal baglamlarinin kullanimini sunabilirsiniz.

e  MAXMaps icindeki grafiksel gosterim secenekleri: Bu fonksiyon ¢zellikle kavram haritalarinin olusturul-
masina olanak tanr.
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Okudugunuz icin tesekkirler

Bu kilavuzu begendiginizi umariz. Elbette, MAXQDA daha fazlasini sizlere sunuyor. MAXQDA ile sizler:
e Ses ve video dosyalarinizin transkripsiyonunu yapabilirsiniz.

e Twitter ve YouTube verilerini iceri aktararak analiz edebilirsiniz.

e Odak grup goértsmelerini analiz edebilirsiniz.

o Verileri gorsellestirebilirsiniz.

e Raporlar olusturabilirsiniz.

e Nicel icerik analizi ve cok daha fazlasini yapabilirsiniz.

MAXQDA programinin pek cok 6zelligi ve farkli fonksiyonlar hakkinda daha fazlasini 6grenmek icin
www.maxqda.com adresini ziyaret edebilirsiniz.

Kongre: MQIC - MAXQDA International Conference (M AXQDA Uluslararasi Konferansi)

Her yil dizenlenen MAXQDA Uluslararasi Konferansi diinyanin dért bir yanindan MAXQDA kullanicilarini bir
araya getiriyor. Konferans calistaylar, poster sunumlari, en iyi pratikler grup oturumlari ve MAXQDA ve
karma ydntemler arastirmasi egitimleri olmak Uzere katiimcilara cok genis yelpazede bir program sunuyor.

Konferans hakkinda daha fazla bilgi edinmek icin www.mgjic-berlin.com adresini ziyaret edebilirsiniz.



